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Please read this manual fully before attempting to install

the AF120 system.
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The AF120 Air/Fuel Ratio control (AFRC) system is designed to continuously monitor the
oxygen content of your engine exhaust and vary the ratio of fuel to air to ensure optimum
combustion and exhaust emissions. It is capable of giving precise control of stoichiometric
(lambda = 1) engines used with three way catalysts for periods of many months of
continuous or intermittent operation without operator intervention. It can also control lean
burn engines (lambda > 1) used with or without an oxidation catalyst. When used in
conjunction with a Gill GS Series Ignition System, many engines can meet emissions
regulations by being run lean and WITHOUT a catalytic converter.

1. Introduction

AF120 controls the operation of a fuel valve or mixer by monitoring the output of the engine
exhaust mounted Oxygen Sensor. It contains an on-board UEGO Interface and uses a
Proportional and Integral control loop that takes the Oxygen Sensor signal as its input and
controls the fuel valve’s position to achieve the set-point exhaust oxygen level.

With its UEGO sensing technology, AF120 is able to control engines to stoichiometric (lambda
=1) or lean (lambda > 1) air/fuel ratios. Various engine control schemes can be used - eg fuel
bypass past the mixer, controllable mixer, turbo waste-gate.

Please Note:

The AF120 AFRC system is not to be used to compensate for incorrect or malfunctioning
components in the fuel system / engine. The engine must be capable of stable running under
full load conditions; any engine components that are malfunctioning must be replaced and
tested before installation of the AF120 AFRC system.

The following aspects of the engine must be verified and working at peak performance
before installation of the AF120 system:-
e Ignition system is optimised, with spark timing providing peak performance, and spark
plugs checked and gapped according to manufacturers recommendations.
e Toensure optimum ignition performance it is recommended that the engine
operator install a Gill Instruments ignition system, particularly for lean burn systems.
Please see www.gillsc.com for our full range.
e Checkvalves are in good condition and set to the manufacturers recommended
clearances.
e Airinlet system is to be checked to ensure a clean, constant flow of air at a given
temperature.
e Carburettor or venturi system must deliver a steady controllable amount of air / fuel
mixture to the engine.
e Dual carburettor or dual turbocharged engines must be correctly balanced to ensure
that both sides receive the same amount of fuel or boost pressure.

Any condition that causes dramatic and / or adverse changes in exhaust emissions
must be corrected if the AF120 AFRC system is to operate successfully.
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2. Installation

The AF120 AFRC system comprises the following components —

e 1495-00-026 AF120 Programmable Air/Fuel Control Module
e 1495-00-030 Fuel Bypass Valve (or other valve as appropriate)
e 037-03997 Bosch UEGO LSU

e 1495-10-022 AF120 Wiring Harness

e AFPcom Programming Software

e 1495-PS-0001 Installation and Operating Manual

o Fuel adjustment needle valve - if required.

Depending on the package purchased from Gill Instruments, some of the above components
may be sourced directly by you.

A typical application would be installed as per the diagram below —

Schematic Diagram for Stoich Engine with Three Way Catalyst

Carburettor Secondary Regulator AF120 AFRC Module

\
Governor @Ej—[—) =T
I [
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F ‘ N Needle Valve*
Fuel Bypass Valve
\ Bosch wideband Oxygen Sensor

N N /

/

—
e

9 ] 1

/ J \3-Way Catalytic Converter

*Required for Evaluation System Only

IMPORTANT:

THE FUEL SUPPLY NEEDS TO BE COMPLETELY SHUT OFF WHEN THE ENGINE IS
STOPPED, INCLUDING THE FUEL BYPASS LINE. THE FUEL BYPASS VALVE IS NOT
INTENDED AS A FUEL SHUTOFF VALVE.
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2.1 Module Installation

It is strongly advised to mount the AF120 module away from excessive sources of heat and
vibration for optimum reliability.

If installed in the engine compartment, mount the AF120 module low down and away from
exhaust pipes and hot air from radiators.

As the Module generates some heat when operating, it is recommended that it is not
mounted on a panel that is subject to heat from the engine; alternatively fit the module to
the panel with “standoffs” that provide an air gap between it and the supporting panel.

Gill Instruments recommends a torque setting not exceeding 3.5Nm (2.61bf ft) for the fixing
bolts. Assuming a standard M6 washer (or larger) is fitted.

The wiring to the fuel bypass valve and the UEGO (oxygen) sensor must be securely routed so
as to avoid contact with any high temperature engine parts, such as the exhaust manifold
and turbocharger.

Important: The wiring to the UEGO (oxygen) sensor MUST be kept clear of the Ignition
Coil LT and HT wiring.

Ensure all connections are secure. A 5A fuse is recommended.

2.2  Fuel Bypass Valve Installation

To ensure the correct operation of the fuel bypass valve ensure the following criteria are met

e The fuel pressure supplied to the fuel bypass valve must be greater then the
regulated fuel being delivered to the mixer device. Very low gas pressure can
cause the valve to work against the gas regulator.

e On turbocharged engines the fuel pressure being delivered to the fuel bypass
valve must be greater than the full load turbo boost pressure.

¢ Onsmaller engines it may necessary to install a manual needle valve, eg
Whitey IRS6, as shown on page 8, to optimise the control range of the bypass
valve. On larger engines or low pressure gas applications it is not necessary to
install this valve.

e The maximum recommended fuel pressure at the bypass valve is 5 psig
(350mbar). On engines where overcoming maximum boost pressure means
exceeding this figure, please contact your Gill Instruments distributor for
assistance and recommendations.

Test Fuel Bypass Valve Before Installation

e Power Up the AF120 module with the Fuel Bypass Valve connected, but not installed
in the fuel line.

e Run AFPcom software (see section 4) and go to the Fuel Valve Screen (see section
43.2).

e (lick on Test Mode on the Fuel Valve Screen — when looking in the inlet of the Fuel
Bypass Valve you should see the needle opening and closing. If there is no
movement, check connections and re-power the system. If there is still no movement
contact an Applications Engineer at Gill Instruments for further advice.
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Mounting

Locate a suitable spot to drill, tap and install a */s" NPT fitting to supply fuel to the fuel
bypass valve. The typical location is on the gas inlet line into the zero pressure
regulator. Gas rated pipe must be used to connect to this NPT fitting. The Whitey IRS6
needle valve, or equivalent, (if required) should be connected inline of this tube or
pipe, then with additional pipe / tubing connected into the inlet of the fuel bypass
valve.

All tubing / pipes and threaded connections must use industry standard gas
tight connector to prevent leaks.

To ensure longevity of operation the Fuel bypass valve should be mounted
away from high levels of vibration and exhaust heat.

Use a /5" NPT fitting from the outlet side of the fuel bypass valve to the engine side of
the carburettor. Drill and tap in the selected location for the size of fitting used for
fixing.

Connect the 4-pin connector on the AF120 wiring harness to the fuel bypass valve.
Ensure all cabling and gas pipes are routed to avoid hot engine parts.

Fuel Bypass Valve
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Please refer to diagram below for typical installation on fuel system of a stoichiometric

engine.
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2.3 Bosch UEGO LSU Oxygen Sensor Introduction and Installation

Introduction

The Bosch LSU sensor requires a controller because it is more complex than a standard
switching type sensor. It can be thought of as being made up of a heated narrow band
oxygen sensor (comprising a Reference cell & Nernst Cell) coupled to a pump cell in contact
with a small chamber with a diffusion gap to the outside (exhaust gas).

The pump cell, in conjunction with a catalytic reaction at the surface of the cell's electrodes,
can either consume oxygen or consume hydrocarbon fuel in the pump cell cavity, depending
on the direction of the current flow.

During normal sensor operation, a small sample of the exhaust gas passes through the
diffusion gap into the pump cell. That exhaust gas is either rich or lean and both conditions
are sensed by the reference cell which produces a voltage Vs above or below a reference
signal (Vref).

A rich exhaust will produce a high Vs voltage and the electronics produces a pump current Ip
in one direction to consume the free fuel. A lean exhaust produces a low Vs and the
electronics sends the pump current in the opposite direction to consume free oxygen.

When the free oxygen or free fuel has been neutralised, the Vs feedback signal goes to about
450 mV (the same as the Vref value). The pump current Ip (which is a measure of the number
of electrons used in the chemical reaction) required to produce this equilibrium is a measure
of the Lambda or Air Fuel Ratio.

Typical Output of a Bosch LSU UEGO Sensor

Pump Current (Ip) vs Lambda for a Bosch UEGO LSU type Sensor
Typical Values
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Pump Current (Ip) vs % 02 for a Bosch UEGO LSU type Sensor
Typical Values
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Installation Instructions
Installation in the exhaust system must be at a point guaranteeing representative exhaust gas
composition and as close to the engine as possible whilst also satisfying the maximum

temperature limits (see also Section 5).

Operating Temperatures:

Exhaust gas at sensor element: < 1706°F (<£930°Q)
Hexagon of the sensor housing: < 1058°F (<570°Q)
Cable grommet (PTFE formed hose) - sensor side: < 482°F (< 250°0)
Cable grommet (PTFE formed hose) - cable side: < 392°F (< 200°0)
Cable and protective sleeve: < 482°F (< 250°C)
Connector: < 248°F (£120°C)
Mechanical data

Thread M18x 1,5
Tightening torque 441bft (60 Nm)
Hex size 22 mm

Design measures:

e Locate sensor as close to the engine as possible, respecting maximum allowed
temperature range

e Attempt to achieve rapid heating-up of the exhaust pipes in the area in front of
the sensor.

e The exhaust pipe in front of the sensor should not contain any pockets,
projections, protrusions, edges, flex-tubes etc. to avoid accumulation of
condensation water. A downward slope of the pipe is recommended.

e Make sure, that the front hole of the double protection tube does not point
against exhaust gas stream.

e Do not use a cleaning / grease fluid or evaporating solid at the sensor plug
connection as this can lead to sensor performance loss and early failure.
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e The UEGO sensor must not be exposed to strong mechanical shocks otherwise
the sensor element may crack without visible damage to the sensor housing.

e The sensor should not be fitted near to the exhaust outlet, to avoid any influence
of outside air. The exhaust-gas passage opposite the sensor must be free of leaks
in order to avoid the effects of leak-air.

e Protect the sensor against condensation water.

e The sensor body must be ventilated from the outside in order to avoid
overheating.

e The sensor is not to be painted, nor is wax to be applied or any other forms of
treatment.

e Only the recommended high temperature grease is to be used for lubricating the
threads (Bosch 5 964 080 112).

e The sensor receives the reference air through the connection cable. This means
that the connector must be clean and dry. Contact spray, and anti-corrosion
agents etc. must not be used.

e The connection cable must not be soldered. It must only be crimped, clamped, or
secured by screws.
Part No.
Bosch Part Numbers used by the AF120 System —
0258007 351
0258007 200
0258007 057
0258007 058
Volkswagen Audi Group Part Number -
021-906-262-B
Standard Motor Products Part number -
SG 897

Gill Instruments Part Number -

037-03997
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3 AF120 Module LED Display

Ol 000 O

LED DISPLAY 36 WAY CONNECTOR

The AF120 Air / Fuel Module has a 3 LED display next to the 36-way connector that displays
the following information:

Left - This LED will flash once every three seconds to indicate that there is power to
the Module and the module is in standby.

1 flash every second shows the Module is enabled and in Operating Mode.

Centre - This LED indicates the Module operating status.
When lit the module is in normal operating condition.

When not lit there is an abnormal operating condition as follows:
= Valve control in Open Loop mode

» |ambda Sensor Temperature out of range

= Valve position out of range

(Note: - When Commissioning the Module the centre LED will be off when in Open-

Loop Mode set-up and should light up when the set-up procedure is completed).

Right - This LED indicates there is Module microprocessor activity.

Note that the digital output from Module connector pin 32 also indicates if the system
is operating correctly (as per centre LED).
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4, Installation of AFPcom Software

This topic covers programming requirements and steps involved to install and run the
AFPcom Graphical User Interface (GUI) software. (See Appendix 5 for details of the optional
IDU-10 Display Unit))

Communications Software
The system is supplied with a Windows®-based AFPcom software CD, designed to run on an
IBM PC or equivalent.

A 9 way D type connector is fitted in the wiring loom. This should be connected to a COM
port of the user’s PC (via a standard comms cable or USB adapter — not supplied).

Operating Systems
Windows NT, Windows 98, Windows 2000, Windows XP

4.1 Installing the AFPcom Software

1. Load the AFPcom Installation CD into the PC.

2. (Click on Start — Run — Browse — locate the “AFPcom” CD icon and click on it.

3. Click on the Setup icon that appears in the window. Click on Open, and then click on
OK.

4. Follow the Wizard Instructions.

4.2 Running the AFPcom software

Before installation and commissioning, please familiarise yourselves with the AFPcom
software by reading the following sections.

Note:

When the AFPcom software is first run and the user clicks on the FILE tab on the Menu Bar, an
additional ADVANCED tab appears.

Clicking on this tab will generate a pop-up box that requests a password.

This password then allows the user to change any parameter.

The password is only required by development engineers working on a new engine type. For
basic engine commissioning and operation, no password is required.
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Start and run the program with an AF120 module connected and powered up.

The following screen will appear:

| connected to comM1 [Mormal Mode oNLINE v
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4.3 AFPcom Menu Tabs

File >
Advanced See above regarding password access
Log Click on this tab to access the Data Logging facility and the following
screen will appear:
il Loaging 10| =]

| 00:00:02
Click on the “Start log” button to start data logging.
Enter the file name — it is a .txt file format. Save to a preferred directory.
Click on “Stop Log” to end the sequence.
The Log.txt file can be retrieved for analysis or forwarded to Gill
Instruments.

Comms Click on this tab if there is no communication with the AF120 Module.
Click on this tab if using a USB to Serial adapter and to select an
available comms port.

After a portis chosen, click on the Connect tab on the Menu Bar to re-
establish communication with the Module.

Exit Closes the AFPcom

View > See section 4.3.1

Connect > Reconnects comms with the AF120 module
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4.3.1 Monitor screen

This is the normal screen for routine performance checks.
To monitor system performance, click on the "View"” menu tab, select the “Monitor” drop
down tab and the following screen will appear:

B Monitor

CPU Fitmweare; | 2265202 SPU Firmweare: |02

Walve Position

Senzor Temperature

Walve

Lambda
Heater Equivalent Lambda Waoltage Lambda Contral Status
Resistance  |5152  Ohms Lambds  |25.083 W P 318780 [~ Contral nat C/Loop
[~ TempOOR
Setpaint |27 100 v Setpoint 307500
- < VaPo 00
Setpoint (Load adj) (237300 a

Vhat (12124
=TI (== = Y

Position  |0.000 %

[ Heater Current 0OR

[~ Configuration Error

Load [ CtlEnable |/P Law
Load W % [~ Start-up not expired
MAP 0000 [ Alam O/P Disabled
MAT o000y

Important Aspects:

Heater
Resistance

Valve
Position

Lambda Control
Lambda
Setpoint

Status

1495-PS-0001 Issue 3

This is an indication of whether the UEGO sensor is able to achieve and
maintain temperature. This figure MUST be between 8.1 and 8.5 ohms.

This figure indicates valve position
Please note, this relates to the amount of gas flow, not actual size

of opening

This is the measured UEGO sensor pumped current
This is the target pumped current used when operating closed loop.

All boxes should be clear during normal operation.
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4.3.2 Fuel Valve Screen
This is the normal screen for installation and commissioning.

(EilLL

" Fuel Valve

=%

Lambda
Setpaint
alve Position

[rput Control Mode
UEGD |3-74963 i
Setpaint 4 iy B Elaedl L
[~ Senzor Temperature Emor | 0.25163 S ITZ M M
P 171182 " Open Loop
| W Low
i Test
Load & 33 Test Step Period [ms)
B Ii . Setpoint Offset 0 " Re-=zemn
% Open ’ “ Adjusted Setpoint 4
Steps u
Important Aspects:
Input
UEGO mA Actual measured Pumped Current in mA, relates to the composition of
the exhaust mixture
Output
% Open Amount of valve opening
Please note, this relates to the amount of gas flow, not actual size
of opening, and is only valid in closed loop mode.
Steps Number of stepper motor steps corresponding to valve position
Control
Setpoint mA Target Pumped Current in milliamps the AF120 control algorithm
works to achieve. This is generally in the region of
-0.04 to -0.09mA for lambda = 1 (stoichiometric) operation or up to
approx +0.5mA for lean burn.
Mode
Closed Loop AF120 module is controlling Fuel Bypass Valve to maintain
stoichiometric air/fuel ratio, by maintaining pumped current to
Setpoint.
Open Loop Fuel Bypass valve can be moved to set positions (see below).
Test Fuel Bypass valve will repeatedly sweep from low to high to low
position at a speed dictated by Test Step Period.
Re-Zero Moves Fuel Bypass valve to fully closed position.

1495-PS-0001 Issue 3
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Open Loop These functions only apply in Open Loop Mode.

Step The valve moves Up or Down by the percentage amount entered. Eg
entering 10 and clicking Up once will move the valve an additional
10% open.

Preset Position Clicking on High moves the valve to its 90% open position, clicking on

Low moves the valve to its 10% open position
Test Step Period This figure is the amount of time between Stepper Motor steps when

Test mode is activated. Eg 150ms equates to a sweep of 30 seconds
between fully closed and fully open.

4.3.3 IDU-10 Display Unit

An optional display unit is available from Gill Instruments Ltd that allows local monitoring of
AF120 operation without use of a PC. The setpoint is also adjustable (under PIN protection).
See Appendix 5.
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To set up and commission the AF120 AFRC system with the standard fuel bypass valve, please
follow the process as detailed below. When the procedure mentions a carburettor, this also
applies to a mixer or a venturi. See Appendix 6 for notes on use of the 4-20mA output for use
with alternative valves.

5.  AF120Initial Set-Up

Stage1 Ensure AF120 AFRC system is working correctly

1) Ensure Fuel Bypass Valve is connected securely into fuel line.

2) Power up AF120 module with the UEGO sensor and Fuel Bypass Valve connected
and check the left hand LED is flashing approximately once per second, and that
the right hand LED is flashing rapidly.

3) Connect AF120 to PC and run AFPcom software. Select Monitor page.

4) Install UEGO sensor into fitting in exhaust

5) Close needle valve (if fitted)

6) Ensure engine is able to run throughout its normal operating range with air/fuel
ratio set up to approximately stoichiometric (or as required)

7) Run engine at idle until it has reached its operating temperature

8) Run engine from idle to full load conditions and ensure that UEGO sensor is able

to maintain temperature under all load conditions. Ramp up engine load in 25%
load steps and check to see if the UEGO sensor temperature stabilises, using the
Monitor page in AFPcom. This can be seen by monitoring on the graph the sensor
temperature settling down to a horizontal line, with the Heater Resistance
between 8.1 — 8.5 Ohms. Check on the Heater page of AFPcom that the required
heater power is approx 3Watts once the temperature is stable.

B Monitor Q@@
CPU Firmware: |22685202 SPU Firmware: 1102

5 Valve Posit
Sensor temperature stabilising after load change sve rosen

=

This figure needs to be between 8.1 and 8.5 Ohms

Sensor Temperature

Lambda

Heater | 1 Equivalent Lambda Yoltage Lambda Control Status
REC ‘@ Ohms Lambda  128.083 W Lambda 319730 oa [ Control not C/Loop
[~ Temp OOR
Setpoint  |27100 v St 307500
Pou 7 VavePO0R
Setpoint (Load adj) |2.97300  a

Vbatt [12124 ™ Heater Current DOR

[~ Configuration Error

8y 8799 v
Load [ ChlEnable I/P Low
0000 s
Ve Load % [~ Start-up not expired
MAP 0000 v [~ Alam 0P Disabled

Positon  |0.000 %

MAT 0.000 v
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9) If the UEGO sensor is not able to maintain temperature, move its position. If the
sensor is not able to reach temperature (resistance too low, or heater power >3W),
move it closer to the engine exhaust manifold; if too hot (resistance too high, or
heater power <3W), move it away.

10) Run the engine under normal operating load conditions. Using AFPcom software,
on the Monitor page, you should see Input UEGO sensor pump current of
approximately OmA for stoich or up to approx 0.5mA for lean burn.

Stage2  Adjust Control Authority

1) Adjust manual valve (if fitted) to mid position (4 turns from fully closed)

2) Using AFPcom software, move Fuel Bypass Valve to mid position by using the
following procedure -

" Fuel Valve E]@
Step 1. Check Valve Position is at Zero  Lambda
If not - click on “Re-zera” in Mode S etpoint
. Walve Pozition
Step 4. Click on Up 4 times
Step 2. Click Open Loop
Step 3. Click on Low Praset Position
Input Contral Mode
UEGD |374969 4 Open Loop
Setpaint 4 ma, & Eloscd L
* (RS oop
[~ Senzor Temperature Emar 025163 m M
| 51200
" Test
Load % 33 Test Step Period [ms)
Outpur e Setpoint Offset g R
= [ B-ZEI0 A0
% Open II' * Adjusted Setpaint 4
Steps | 80
3) With the engine running at normal operating load, use third party emissions test

equipment to set air/fuel ratio to the desired value by adjusting the carburettor /
venturi mixture screw or equivalent.
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4) Now test the system’s authority. Using AFPcom software, move the Fuel Bypass
Valve from 10% open to 90% open using the following procedure —
" Fuel Valve g@
Lambda
Setpoint

Walve Position

F
Step 2. Click on Low to/maove the valve to the 10% apen position

/
Step 3. Click on High to mogé the valve to the 90% open position
S

r
J,-f Step 1. Click on Open Loop Mode
i

Input Cantral Mode
JEFO |2 74963 .y
Setpoint q e, 9 Tl
* DEE aop
[ Senzor Temperature Ermor | 0-25163 Drovn
P 171182
| 51200
" Test
Load & 33 Test Step Period [ms]
utput Setpoint Offset U
ZOpen |0 % A (" Rezern 250
Adjuzsted Setpoint 4
Steps u
5) If your emission test equipment is able to measure lambda the ideal lambda range

from Low position to High position is approximately 0.95 to 1.05 (for stoich

operation with a three way catalyst). The corresponding UEGO pump current

range is approximately +0.1mA.

a. Iflambda range is too high, close needle valve approximately ¥4 turn, then go
back to step number 2

b. If lambda range is too small, open needle valve approximately ¥4 turn, then go
back to step number 2

Please Note: Excessive authority might cause the engine to be unstable - the

operator should monitor the engine and be prepared to reset the bypass

valve to midpoint if problems are detected.
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Stage 3b
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Using AFPcom set the Control Setpoint to —0.04mA and press enter (this box will
go red until Enter is pressed).

Run engine up to its nominal operating load, wait for engine to reach its normal
operating temperature.

Click on Mode > Closed Loop and wait for engine to stabilise.

Using AFPcom adjust Control Setpoint in small steps while monitoring the Input
UEGO control pumped current output and third party emissions test equipment
until emissions are reduced to satisfactory levels This figure is generally in the
range of -0.09 to -0.04mA.

Run engine from idle to full load in steps on 25% load, and using third party
emissions test equipment, ensure that AF120 system is maintaining stoichiometric
conditions.

Install catalyst and fine tune set-point with catalyst fitted for optimum emissions
(refer to catalyst instructions).

Capture Setpoint (for stoich + three way catalyst)

Capture Setpoint (for lean burn operation)

Use the procedure in 3a above, but with a setpoint as required between 0 and approx
+0.5mA. If you have access to Advanced mode (see p12), it is possible to configure AF120 to
use a MAP sensor to automatically adjust the setpoint as a function of engine load. Contact
your Distributor or Gill Instruments for more information.

Note:- see section 6 for information regarding engine start-up conditions.
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Engine Start-up

The base AF120 configuration provides the following functionality —

On powering the module the AF120 system will close the valve

The valve will stay closed for 60 seconds

After 60 seconds the AF120 will go into closed loop mode and the valve will open

If the valve approaches the top or bottom of its travel within the first 60 seconds of
closed loop mode, the AF120 will not report an error, this is to allow the system to
settle down.

After 60 seconds of closed loop mode the system will report an error if the valve hits
the top or bottom of its travel.

If you have advanced access (see page 12) to the AFPcom software you can amend this
functionality to change the start-up time and the start-up position.

To do this go to the configuration page - the parameters concerned are CloseOnStartPeriod
and StartupPos.

To use external control of when AF120 enters closed loop mode, the Enable Input may be

used:-
Pin 33 Grounded: Inhibits control — valve moves to start-up position
Pin 33 Open Circuit: Enables closed loop control
Closed loop control will not begin until the CloseOnStartPeriod
has elapsed AND the enable line is open circuit.
7. Troubleshooting
Power

If the left hand LED on the AF120 is not flashing when the power to the module is
turned on, ensure 12-24V power and ground are connected.

Verify with a voltmeter to check power at module, 12 — 24V is required at Pin 1 and Pin
11. If there are still problems please contact Gill Instruments for an application
engineer’s assistance.

Oxygen Sensor

If the oxygen sensor is not able to reach the stable, controlled operating temperature
after moving sensor around to find optimum position, use the data logging facility in
the AFPcom software to capture 10 — 20 seconds of module operation and email to
info@gillsc.com with your contact information. An application engineer will contact
you to assist.
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8. WIRING DIAGRAM (Module Connector Pin-out arrangement)

Note that Pin 1 is located at the bottom right hand side of the Igniter connector (cable entry
side). Pins are numbered right to left in each row.

Pin

1
2
3
4
5
6
7
8
9
1
1
1
1

Description
Power +ve
Power —ve
Power —ve

Lambda Sensor (0V)

Stepper D
Stepper A

RS232 TX

RS232 RX
Stepper C
Stepper B
Lambda Heater HI
Lambda Pump
Lambda

Lambda Heater LO
4-20mA Output
Status Line
Enable Line

1495-PS-0001 Issue 3

Comment

Permanent Power In (+31V Max)
Power Ground (0V)

Power Ground (0V for RS232)

For laptop or Gill IDU-10 Display Unit
For laptop or Gill IDU-10 Display Unit

For use with a 3 Party fuel valve. See App 6.
Indicates error condition
See section 6.
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Appendix 1 Bosch UEGO Sensor Installation Boss

@ 25

) 18.5 M18x 1.5

(701 102 Rz30

@ 23

min. 10.5
(" min. 13 )

Threaded Boss for Installation of UEGO sensor into exhaust
All dimensions in mm

Recommended material -
Temperature Resistance Stainless Steel e.g SAE 30305
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Appendix 2 AF120 AFRC System Wiring Diagram
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Appendix 3 AF120 Module Assembly
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(All dimensions in mm except where shown otherwise)
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Appendix 4 Fuel Bypass Valve Assembly
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Appendix 5 IDU-10 Display Unit

An optional display unit is available from Gill Instruments. The display connects to the AF120
via the RS$232 serial communications link and allows all the basic operator functionality that is
also provided in AFPcom. All operating parameters can be monitored, and there is a PIN-
protected facility to adjust the set-point.

The display is available in panel mount and surface mount formats.

Contact your Gill distributor or visit www.gillsc.com for more details.

: Gill Instruments Ltd.

Appendix 6 Use of 4-20mA Output

A 4-20mA control output is available instead of the stepper drive. This can be activated by
using Advanced access to AFPcom (see p12).

The 4-20mA o/p can be used to control a pneumatic actuator driving a turbo wastegate. It
can also be used to drive a controllable mixer or venturi.

All features described in this manual are available with both stepper and 4-20mA drive.

Contact your Distributor or Gill Sensors & Controls for more details.
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